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Field Information

Composing a Message:
Attach:
Bcc:
Body:
Cc:
Certify:
Defer:
Expire:
Priority:
Subject:
To:

Editing an Address Book Entry:
Label:
Address:

Editing the Compose Options:
Automatic Certify:
Default Destination:
Line Length:
Font:
Signature:

Editing the Folder Options:
Sort Order:
Font:

Editing the General Options:
Disable Warning Messages:
Check for STDA:
Save & Restore Icon Position:
Default Save Directory:
Answer Button Action:
Original Copy Options:

Editing the Printing Options:
Footer Options:
Font:

Editing the Reading Options:
Delete Button Action:
Font:

Editing a Folder Name:



Folder Name:



How To ...
Following is a list of procedures for manipulating messages, attachments and folders in HappyMail.

Messages:
Create a Message
Delete a Message
Edit a Message
File a Message to a DOS file
Forward a Message
Move a Message to a New Folder
Print a Message
Read a Message
Send a Message

Attachments:
File an Attachment
View an Attachment
Launch an Attachment
Print an Attachment

Folders:
Create a Folder
Delete a Folder
Open a Folder
Rename a Folder



Error Codes
Click on one of the following Banyan Mail error codes for more information:

VNM3001 -- INCORRECT NAME SYNTAX

VNM3008 -- THE MESSAGE SERVICE IS NOT RESPONDING

VNM3011 -- UNEXPECTED FAILURE CONDITION

VNM3015 -- A RECIPIENT'S ADDRESS IS INCORRECT

VNM3017 -- THE SESSION HANDLE IS NO LONGER VALID

VNM3019 -- ENVELOPE FILE FOR THIS MESSAGE IS MISSING

VNM3020 -- CONTENT FILE FOR THIS MESSAGE IS MISSING

VNM3025 -- PROFILE ENTRY FOR MAIL IS MISSING OR INCORRECT

VNM3027 -- ATTACHMENT FILE FOR THIS MESSAGE IS MISSING

VNM3030 -- THE FOLDER ALREADY EXISTS

VNM3031 -- THE FOLDER COULD NOT BE FOUND

VNM3036 -- RETRY PERIOD EXPIRED

VNM3041 -- WRITE ERROR ON DISK

VNM3042 -- NAME NOT FOUND

VNM3043 -- MAILBOX IS FULL

VNM3044 -- SYNTAX ERROR IN RECIPIENT LIST

VNM3045 -- MAIL SERVICE NOT FOUND

VNM3046 -- WILDCARDS RESTRICTED

VNM3047 -- NO MAIL SERVICE SPECIFIED IN PROFILE

VNM3048 -- MAILBOX DISABLED

VNM3049 -- LIST NESTING



VNM3050 -- INVALID MESSAGE ID

VNM3051 -- INVALID MESSAGE SUBMISSION

VNM3057 -- ERROR READING ENVELOPE

VNM3062 -- MESSAGE MAIN BODY IS TOO LARGE

VNM3066 -- EXCEEDED MAX BUFFER LENGTH

VNM3067 -- ILLEGALLY FORMED ADDRESS

VNM3068 -- ADDRESS TOO LARGE

VNM3069 -- UNBALANCED NUMBER OF BRACKETS

VNM3070 -- FOLDER NAME EXCEEDS 14 CHARACTERS

VNM3073 -- CANNOT TRANSFER ALL ATTACHMENTS

VNM3074 -- MESSAGE CANNOT BE DELETED

VNM3077 -- ZERO ENUMERATIONS IN LIST OR TEMPLATE

VNM3078 -- DECOMPRESSION FAILED

VNM3079 -- FAILED CONVERSION FOR REMOTE SERVICE



VNM3001 -- INCORRECT NAME SYNTAX.
If you cannot access Mail because of this message, you can try entering "whoami" at the 
DOS prompt to verify that your login name is correct.    If the name is not correct, try logging 
out and back in, and then try to access Mail.    If this message appears and you are in Mail or 
can access Mail, open the Compose screen and check the From: field to see if your login 
name is correct.    If the login name is not correct, you can try exiting Mail, logging out and 
back in to correct the problem.



VNM3008 -- THE MESSAGE SERVICE IS NOT RESPONDING.
Mail service is not available.    Verify the status of the mail service on the server on which it 
resides.    Either the server or the mail service is down.



VNM3011 -- UNEXPECTED FAILURE CONDITION.
Check the status of the services at the server console.



VNM3015 -- A RECIPIENT'S ADDRESS IS INCORRECT.
The format of a recipient's address was not correct.    This message usually indicates an 
undeliverable message.    The message will be returned.    Resend it.



VNM3017 -- THE SESSION HANDLE IS NO LONGER VALID.
A connection between the client and the service is interrupted during the session, and you 
attempt to access the service.    Before you can access the service again at the PC, a new 
session should be started. Try exiting the service and reentering.    If necessary, try logging 
out and back in again.    Rebooting the PC is a final option (pressing CONTROL plus ALT plus 
DELETE).

A session is a period of time in which the mail program in    your PC (also known as the 
"client") and the mail service are logically connected and interacting.    The session handle is 
the identifier of the current session between the mail client program in the PC and the mail 
service.



VNM3019 -- ENVELOPE FILE FOR THIS MESSAGE IS 
MISSING.
Communication interruption between the client and server on which your mail service 
resides may produce a situation in which it appears that you cannot delete or read a mail 
message.    The problem occurs because the delete request    timed out at the client, but the 
mail service actually completed the deletion.    Because the client assumes that    the 
message was not deleted, any attempt to access the message produces an error.

Try accessing the message again, or exit and re-enter the Mail utility.    If the problem 
persists, report the problem to your system administrator.



VNM3020 -- CONTENT FILE FOR THIS MESSAGE IS MISSING.
Communication interruption between the client and server on which your mail service 
resides may produce a situation in which it appears that you cannot delete or read a mail 
message.    The problem occurs because the delete request    timed out at the client, but the 
mail service actually completed the deletion.    Because the client assumes that the message
was not deleted, any attempt to access the message produces an error.

Try accessing the message again, or exit and re-enter the Mail utility.    If the problem 
persists, report the problem to your system administrator.



VNM3025 -- PROFILE ENTRY FOR MAIL IS MISSING OR 
INCORRECT.
Check the user's profile.    The entry in the profile that lets the user access the mail service 
may contain an error or may be missing entirely.



VNM3027 -- ATTACHMENT FILE FOR THIS MESSAGE IS 
MISSING.
Communication interruption between the client and server on which your mail service 
resides may produce a situation in which it appears that you cannot delete or read a mail 
message.    The problem occurs because the delete request    timed out at the client, but the 
mail service actually completed the deletion.    Because the client assumes that    the 
message was not deleted, any attempt to access the message produces an error.

Try accessing the message again, or exit and re-enter the Mail utility.    If the problem 
persists, report the problem to your system administrator.



VNM3030 -- THE FOLDER ALREADY EXISTS.
You entered a folder name that already existed.    Enter a different name.



VNM3031 -- THE FOLDER COULD NOT BE FOUND.
You attempted to delete or rename a folder, and the mail service could not locate it.    Try 
again.    You may have deleted or renamed the folder already.



VNM3036 -- RETRY PERIOD EXPIRED.
If a user sends a message with an unverifiable address, Mail will keep trying to deliver the 
message for a time period specified by the message expiration time.    If the message cannot
be delivered within that period, the sender receives a notice of undeliverable mail with this 
error code.

Check the address on the message, and make any necessary corrections.    If the address 
appears to be correct, verify that the connections to the recipient are working properly and 
that the recipient's group still exists.



VNM3041 -- WRITE ERROR ON DISK.
This message appears for any one of the following reasons:    the disk is full, the disk is read-
only, or an I/O error occurred during the attempt to write the message to disk.    File the 
message on another disk.



VNM3042 -- NAME NOT FOUND.
Mail cannot deliver the message for one of the following reasons:    the appropriate StreetTalk
is not available; the recipient's user name was deleted; the recipient's name was not entered
correctly.    Verify the accuracy of the name entered.    If the name is correct, check to see if 
the name was deleted.    If the name is correct and exists, check the connections between 
the recipient and the sender.



VNM3043 -- MAILBOX IS FULL.
The message cannot be delivered because the recipient's mailbox contains the maximum 
number of messages, as set by the system administrator.    The recipient must delete some 
messages before any other messages can be delivered.
      
The default limit is 1000 messages.    Administrators can set lower limits if required using the
Change mailbox settings function available in the Manage User menu (MUSER).    The 1000 
message limit is the maximum allowed by the Mail program.    If this limit is reached, the 
recipient must delete some of the messages before the mailbox can accept any more 
incoming messages.



VNM3044 -- SYNTAX ERROR IN RECIPIENT LIST.
Mail could not deliver the message because of a syntax error encountered in a list of 
recipients.    The user should recover the message and verify the addresses for correct 
syntax.



VNM3045 -- MAIL SERVICE NOT FOUND.
The message could not be delivered because the name of the mail service in the recipient's 
user profile is incorrect or invalid.    Notify the recipient of the problem.

The recipient's system administrator should verify the name of the mail service in the user 
profile of the recipient and make any necessary corrections.    If the mail service name is 
correct, the administrator should verify the status of the mail service.



VNM3046 -- WILDCARDS RESTRICTED.
This error code indicates that a recipient's mailbox has been restricted from receiving mail 
with wildcards.

If necessary, the sender can recover the undelivered message and forward it to specific 
addresses.    The system administrator can change the restriction using the Change mailbox 
settings function available in the Manage User menu (MUSER).



VNM3047 -- NO MAIL SERVICE SPECIFIED IN PROFILE.
Mail could not deliver the message because the appropriate SETMAIL command has not 
been entered in the recipient's user profile.    Notify the recipient of this problem.

The recipient's system administrator should verify that the user profile contains the 
appropriate SETMAIL command and mail service name.
      
If changes to the profile are made, the recipient must log out and then log back in before 
Mail can deliver the message.

The sender can recover the message and forward it when the recipient's user profile 
problem has been resolved.



VNM3048 -- MAILBOX DISABLED.
The user's mailbox has been disabled by the system administrator.    While disabled, the user
cannot send or receive mail.    The administrator can enable the mailbox using the Change 
mailbox settings function available in the Manage User menu (MUSER).



VNM3049 -- LIST NESTING.
Mail cannot deliver the message because the recipient is a list name that has more than 
three levels of list names nested within it.

For example, a user addresses a message to the list name MyList@Dept@Company (first 
level).    

This list name contains the list name DeptList@Dept@Company (second level).

DeptList contains the list name, VPList@Dept@Company (third level).

VPList contains the list name, PRList@Mktg@Company. (fourth level).    Mail cannot deliver 
the message to MyList because of this fourth-level list name.

Remove one or more of the levels of the list nest.



VNM3050 -- INVALID MESSAGE ID.
A mail client issued a call with a mail message ID that exceeds 14 characters.    The ID is 
specified in the MSGID parameter.    This error appears for mail clients written only with the 
Mail Client API.



VNM3051 -- INVALID MESSAGE SUBMISSION.
A mail client failed in an attempt to submit all or part of a message body part to a mail 
service. For example, the error is returned when the last call to VnsStoreMailBodyPart for a 
body part did not have a zero immediately after the last byte of data.    This error appears for
mail clients written only with the Mail Client programming interface.



VNM3057 -- ERROR READING ENVELOPE.
A mail gateway service could not read an envelope or a recipient address within an 
envelope. This error returns on the MS_READENV and MS_READRECIPINFO calls.    Typically, 
this error occurs when an envelope exists but is incorrectly constructed. This error appears 
for mail gateway services written with the Mail Gateway API.



VNM3062 -- MESSAGE MAIN BODY IS TOO LARGE.
A mail gateway service issued an MS_TRANSFERMES call to transfer a message to a Mail 
service, and the call specified a value greater than 6000 bytes for ms_maxmainbodysize.    
This error appears for mail gateway services written with the Mail Gateway API.



VNM3066 -- EXCEEDED MAX BUFFER LENGTH.
A mail client call specified a buffer length greater than 1024 bytes.    This error appears for 
mail clients written only with the Mail Client programming interface.



VNM3067 -- ILLEGALLY FORMED ADDRESS.
A mail client user specified a recipient address that is either not a StreetTalk address or not a
gateway address.    Legal address formats are described in the Mail User's Guide.    This error 
appears for mail clients written only with the Mail Client programming interface.



VNM3068 -- ADDRESS TOO LARGE.
A mail service attempted to parse or store a recipient address that exceeds 512 bytes.    This
error appears for mail clients written only with the Mail Client programming interface.



VNM3069 -- UNBALANCED NUMBER OF BRACKETS IN 
FOREIGN ADDRESS
A mail service attempted to parse or store a recipient address that has an unequal number 
of left brackets ([) and right brackets (]).    Brackets are used in gateway addresses and 
force-routed addresses.    For each left bracket in a recipient address, there must also be a 
right bracket.    The error is only returned if an address has more right than left brackets.    If 
an address has more left than right brackets, the MS_ILFORMADDR error is returned.    This 
error appears for mail clients written only with the Mail Client programming interface.



VNM3070 -- FOLDER NAME EXCEEDS 14 CHARACTERS
A mail client user attempted to create a folder name that exceeds 13 characters. Folder 
names can only be 13 characters.    The buffers that hold folder names should be 14 
characters to hold the null terminator.    This error appears for mail clients written only with 
the Mail Client programming interface.



VNM3073 -- CANNOT TRANSFER ALL ATTACHMENTS
If you send a mail message with a large number of attachments to a destination mail service
that is running an earlier revision of Mail, you receive a notice of undeliverable mail with this
error code.    The mail message cannot be delivered because the destination mail service 
does not support that number of attachments.

Try splitting up the attachments among several messages, so that each message contains 
only a few attachments.



VNM3074 -- MESSAGE CANNOT BE DELETED
When you use the Delete a Message function of the MMAIL program to delete a message 
that does not belong to you, Mail sends a special notification message to the message owner
stating that you deleted the message. This special notification message can only be deleted 
by the message owner. If you try to delete the notification message, you receive this error 
message.



VNM3077 -- ZERO ENUMERATIONS IN LIST OR TEMPLATE
If you send a message with a list or template (*) in the address field, and Mail determines 
that the list or template contains no recipients, you receive a notice of undeliverable mail 
with this error code.

Check the address on the message, and make any necessary corrections.    If necessary, 
send the message to specific addresses, rather than to a list or template.



VNM3078 -- DECOMPRESSION FAILED
The mail service compresses messages when the message and its attachments are large. If 
the destination mail service fails when decompressing a message, you receive a notice of 
undeliverable mail with this error code.

Try resending the message.



VNM3079 -- FAILED CONVERSION FOR REMOTE SERVICE
Mail cannot deliver the message because the address could not be converted as required.

Check the address on the message for correct format, and make any necessa



Menu Commands

Mail Menu
Read
Edit
Delete
Send
Forward
Compose
Answer

To Sender
To All
To Sender with Original Copy
To All with Original Copy

Print
Move
File
Exit

  
Edit Menu

Cut
Copy
Paste
Delete
Undo

  
Utility Menu

Manage Folders
Manage Attachments
Text Search
Attach Files
Import Files
Address Book
Spell Check
StreetTalk Names

 
 Options Menu

Composing
Folder
General
Printing
Reading

 Windows Menu
Cascade
Tile
Arrange Icons



Mail Menu
The Mail Menu provides all the commands needed for manipulating mail messages.    

These are the Mail Menu commands:

Read
Edit
Delete
Send
Forward
Compose
Answer

To Sender
To All
To Sender with Original Copy
To All with Original Copy

Print
Move
File
Exit



Edit Menu
The Edit Menu provides commands to cut, copy, paste, and clear text from Compose Windows and to 
copy text from a Read Window.

These are the Edit Menu commands:

Cut
Deletes the selected text from the current mail message and places it onto the Clipboard, replacing the 
previous Clipboard contents. 

Copy
Copies the selected text from the current mail message onto the Clipboard, leaving the original intact and 
replacing the previous Clipboard contents. 

Paste
Pastes a copy of the Clipboard contents at the insertion point or replaces selected text in the current mail 
message. 

Delete
Deletes selected text from the current mail message, but does not place the text onto the Clipboard.    

Undo
Undoes your last editing or formatting action, including cut and paste actions. 



Utility Menu
The Utility Menu provides various utilities for managing your mail box,    selecting recipients for outgoing 
messages, viewing attachments, and importing text files.    

These are the Utility Menu commands:

Manage Folders
Manage Attachments
Text Search
Attach Files
Import Files
Address Book
Spell Check
StreetTalk Names



Options Menu
The Options Menu allows the user to modify all of the Happy Mail options.    The options have been 
organized into five groups, according to the operations which they affect most: Composing, Folders, 
General, Printing, and Reading. 

These are the Options Menu commands:

Composing

Folder

General

Printing

Reading



Windows Menu

The Window Menu contains window management commands for manipulating any open Read Window or
Folder Window. 

At the bottom of the Window Menu is a list of open windows. If there is more than one, you can switch to 
another window and make it active by selecting it from the list.

These are the Window Menu commands:

Cascade 
The Cascade command stacks all open edit windows.    This option overlaps open windows so each is the
same size as all others and only part of each underlying window is visible.

Tile 
The Tile command tiles your open windows.    This option arranges the windows so they cover the entire 
desktop without overlapping one another.

Arrange Icons
The Arrange Icons command rearranges any icons on the desktop.    Rearranged icons are evenly 
spaced, beginning at the lower left corner of the desktop.



Reading a Mail Message

'Read' allows you to view a message which is listed in the current folder.    Read also allows you to edit a 
message that you composed but did not send.

Select the message you want to read,    and press <ENTER> or click the [Read] button.    HappyMail then 
displays a Read Window containing the message.

If the message is one you have composed but not yet sent, you can use Read or Edit to load the 
message into a Compose Window for editing.

To proceed to the next or previous message without exiting from the Read Window, you may select either 
the [NEXT] or [PREV] button from the button bar.    These buttons will cause the next (or previous) mail 
message to be read into the current Read Window,.

You may exit from a Read Window in one of three ways: 1) select Close from the system menu, 2) press 
the <ESC> key, or 3) double-click on the right mouse button while the mouse cursor is over the Read 
Window.



Editing a Mail Message
'Edit' allows you to edit a message which is listed in the current folder.    Only UNSENT messages (a 
message that you composed but did not send) may be edited.

Select the message you want to edit,    and press <ENTER> or select Edit from the Mail Menu.        
HappyMail then displays a Compose Window containing the message.

Press <F1> for help in editing any of the fields.

To exit from a Compose Window select Close from the system menu or use the mouse to select the OK 
button.    Selecting the CANCEL button will also exit, but will cause all changes to be lost.



Deleting a Mail Message

'Delete' allows you to remove a message from the current folder.    All deleted messages are moved into 
your Wastebasket folder, where they remain until the Mail "Janitor" program deletes them at 4:00 AM of 
the next day.    Messages deleted from the Wastebasket folder are gone forever. 

Deleting from a Folder Window:
Select the message(s) you want to delete, and click on the [DELETE] button or select Delete from the 
Mail Menu.    If you have selected more than one message, Happy Mail will ask you to confirm the 
deletion.    Also, if you have not read one or more of the mail messages, Happy Mail reminds you that it 
has not been read and asks you to confirm the deletion.

Deleting from a Read Window:
If you wish to delete the current message you a reading, simply click on the [DELETE] button or select 
Delete from the Mail Menu.    After deleting the message, the Read Window will follow one of three 
actions:

a) it will proceed to read the Next mail message,
b) it will proceed to read the Previous mail message, or
c) it will close the Read Window and return you to the Folder Window.

The default action is to close the window.    This default Delete Mode can be changed from the Read 
Options window, which is accessed by selecting Reading from the Options Menu.



Sending a Mail Message

'Send' allows you to send a previously composed message from a Folder Window.

Select the message you want to send,    and click on the [SEND] button or select Send from the Mail 
Menu.    Happy Mail sends the message, then changes the status of the message from UNSENT to SENT.

Note: Attempting to send more than one mail message is not supported and will result in an error 
message from Happy Mail.



Forwarding a Mail Message

'Forward' allows you to forward a message you have received or composed and sent..

Select the message you want to forward,    and click on the [FORWARD] button or select Forward from 
the Mail Menu.    Happy Mail then places you in the Forward Window and prompts you for a new set of 
recipients and a comment.    

To enter new recipients, you may type in StreetTalk names, lists or patterns.    Also, you may select the 
[NAMES] button in order to choose names from a list of all network users.

To use your on-line address book to select entries for automatic insertion, click on the    [ADDRESS BK] 
button. 

In the Message field, you can add your own comments to the message you are forwarding (a maximum of
60000 characters total including the original message).

If you want the forwarded message certified, click on the Certify check box.    You will receive notification 
when the forwarded message has been read.    The default is uncertified, but the default may be changed 
by selecting Automatic Certify from the Options Menu.

Click the <OK> button when you have completed the address, message, and certify fields.    Happy Mail 
verifies the addresses, creates a copy of the old message with your comments added, and then asks if 
you wish to 'Save and Send' or 'Save and Delete'. 

If you select 'Save and Send', the new message will be added to the current folder and then sent to the 
new recipients.    If you choose 'Save and Delete' the new message will be added to the WasteBasket 
folder and then sent to the new recipients..

To cancel a forward request, click on the <CANCEL> button.



Composing a Mail Message

'Compose' allows you to compose a mail message.

To begin composing, click on the [COMPOSE] button or select Compose from the Mail Menu.    Happy 
Mail then places you in the Compose Window, allowing you to fill in various fields (To:, CC:, Subject:, 
Body:, etc.).

For more help on a particular field, enter the Compose Window, move the cursor to the specific field and 
press <F1>.    
 
In the Compose Window, your StreetTalk name appears in the From field, and the current date and time 
appear in the Date field. All fields are optional except the To: field.

To enter recipient names in the To, CC, and BCC fields, you may type in StreetTalk names, lists or 
patterns.    Also, you may click on the [NAMES] button or select StreetTalk Names from the Utility Menu in 
order to choose names from a list of all network users.

To use your on-line address book to select entries for automatic insertion, click on the    [ADDRESS BK] 
button or select Address Book from the Utility Menu. 

To attach files to the message, click on the [ATTACH FILES] button or select Attach Files from the Utility 
Menu.    This will bring up a list of all available files on all attached drives to choose from.

If you wish to import a text file into the body of your message, click on the [IMPORT FILES] button, or 
select Import Files from the Utility Menu.    If the file is too big to import completely, only the beginning of 
the file will be inserted.

If you want the message certified, click on the Certify check box.    You will receive notification when the 
message has been read.    The default is uncertified, but the default may be changed by selecting the 
Automatic Certify option in the Compose Options Window.

When you have completed the message,    click on the <OK> button.    Happy Mail then verifies the 
addresses,    and    asks if you wish to 'Send and Delete' , 'Send and Save' or 'Save'. 

If you select 'Send and Delete', the message will be added to the WasteBasket folder and then sent to the
specified recipients.    If you choose 'Save and Delete' the message will be added to the current folder and
then sent along.    If you select 'Save',    the message will be saved (with a status of UNSENT) in the 
current folder.

To cancel the message at any time, click on the <CANCEL> button.



Answering a Mail Message (to Sender)

'Answer to Sender' allows you to reply to the original sender of a mail message.    The To: field is 
automatically filled with the sender 's StreetTalk name. The subject is also copied over from the original 
message.

From the Folder Window:
Select the message you wish to reply to,    and click on the [ANSWER] button or select Answer to Sender 
from the Mail Menu.    Happy Mail then places you in the Compose Window and fills in the To: and the 
Subject: fields for you.
 
From the Read Window:
Click on the [ANSWER] button or select Answer to Sender from the Mail Menu.    Happy Mail then places 
you in the Compose Window and fills in the To: and the Subject: fields for you.

Proceed with composing the message as normal.



Answering a Mail Message (to All)
'Answer to All' allows you to reply to all recipients of a mail message.    The To: field is automatically filled 
with the sender 's StreetTalk name and all the other original recipients named in the To: field.    The CC:, 
BCC:, and Subject: fields are also copied over from the original message.

From the Folder Window:
Select the message you wish to reply to,    and select Answer to All from the Mail Menu.    Happy Mail then
places you in the Compose Window and fills in the appropriate fields for you.
 
From the Read Window:
Select Answer to All from the Mail Menu.    Happy Mail then places you in the Compose Window and fills 
in the appropriate fields for you.

Proceed with composing the message as normal.



Answering a Mail Message (to Sender with Original Copy)
'Answer to Sender with Original Copy' allows you to reply to the original sender of a mail message.    The 
To: field is automatically filled with the sender 's StreetTalk name and the subject is also copied over from 
the original message.    In addition, the body of the new message is filled with the text from the original 
message.

From the Folder Window:
Select the message you wish to reply to,    and select Answer to Sender with Original Copy from the Mail 
Menu.    Happy Mail then places you in the Compose Window and fills in the appropriate fields for you.
 
From the Read Window:
Select Answer to Sender with Original Copy from the Mail Menu.    Happy Mail then places you in the 
Compose Window and fills in the appropriate fields for you.

Proceed with composing the message as normal.



Answering a Mail Message (to All with Original Copy)
'Answer to All with Original Copy' allows you to reply to all recipients of a mail message and quote the 
original message.    The To: field is automatically filled with the sender 's StreetTalk name and all the other
original recipients named in the To: field.    The CC:, BCC:, and Subject: fields are also copied over from 
the original message.    In addition, the body of the new message is filled with the text from the original 
message.

From the Folder Window:
Select the message you wish to reply to,    and select Answer to All with Original Copy from the Mail 
Menu.    Happy Mail then places you in the Compose Window and fills in the appropriate fields for you.
 
From the Read Window:
Select Answer to All with Original Copy from the Mail Menu.    Happy Mail then places you in the Compose
Window and fills in the appropriate fields for you.

Proceed with composing the message as normal.



Printing a Mail Message

'Print' allows you to print message(s) from your current folder.

Printing from a Folder Window:
Select the message(s) you want to print, and click on the [PRINT] button or select Print from the Mail 
Menu.    If you have selected more than one message, Happy Mail will ask you to confirm before printing.   

Printing from a Read Window:
If you wish to print the current message you a reading, simply click on the [PRINT] button or select Print 
from the Mail Menu while in the Read Window.

Once you have clicked on the [PRINT] button, the Print Window will appear allowing you to set various 
settings (e.g. which printer to use, or the number of copies to print) .    Press [OK] to begin printing or 
<CANCEL> to cancel the operation.

A bar graph window will appear while the message(s) are being printed.    If you wish to cancel the print 
operation at any time, simply press the [CANCEL] button.    Once the print job has been spooled to the 
printer,    VINES will notify you with a Vines Message Box.



Moving a Mail Message

'Move' allows you to move message(s) to a different mail folder (new or existing).

Moving from a Folder Window:
Select the message(s) you want to move, and click on the [MOVE] button or select Move from the Mail 
Menu.    If you have selected more than one message, Happy Mail will ask you to confirm before moving.

Moving from a Read Window:
If you wish to move the current message you a reading, simply click on the [MOVE] button or select Move
from the Mail Menu while in the Read Window.

The Move Window will appear displaying a list of all available mail folders and a button marked    [NEW 
FOLDER].    

Moving to an existing folder:
Select the folder name from the Move Window and click on the [OK] button.    You may also double click 
on the desired folder name.    Happy Mail then files the message(s) in the selected folder.

Moving to a new folder:
If an appropriate folder does not exist,    click on the [NEW FOLDER] button.    You will be prompted for a 
new folder name.    Type in a name of no more than 13 alphanumeric characters, and press <ENTER>.    
Happy Mail verifies the name and files the message in the new folder.

SEE ALSO:     Filing Mail Messages



Filing Mail Message(s) 

'File' allows you to file one or more messages to a DOS file.

Filing Messages:
--    From a Folder Window, select the message(s) you want to file and click on the [FILE] button or select 
File from the Mail Menu.
--    From a Read Window, simply click on the [FILE] button or select File from the Mail Menu.
--    A FileName Window will then appear asking you to enter a new file name or select an existing one.
--    At this point you may also elect to save any attachments by selecting the [SAVE ATTACHMENTS] 
check box.
--    After choosing a file name simply click on the [OK] button to begin the filing operation or click on 
[CANCEL] to abort the operation.

SEE ALSO:     Moving a Mail Message



Managing Attachments

The 'Managing Attachments' utility allows you to file, view, print, or launch attachments from within 
HappyMail.    The utility is started by selecting 'Manage Attachments' from the Utility Menu, or by clicking 
on the [ATTACH] button from within the Read Window.

Filing an Attachment:
--  Select the attachment you wish to file from the listing, and click on the [FILE] button.
--    If you have checked the 'Use Default File Name & Directory' box, the attachment will automatically be 
saved to the default directory with its previous file name.
--    If    'Use Default File Name & Directory' box has not been checked,    a FileName Window will appear 
asking you to enter a new file name or select an existing one. 
--    After entering a file name click on [OK] to begin the filing operation, or click on [CANCEL] to abort the 
process.

Filing All Attachments:
--    Click on the [FILE ALL] button.
--    If you have checked the 'Use Default File Name & Directory' box, the attachments will automatically be
saved to the default directory with their previous file names.
--    If    'Use Default File Name & Directory' box has not been checked,    a FileName Window will appear 
asking you to enter a new file name or select an existing one for each of the attached files. 
--    After entering a file name click on [OK] to begin the filing operation, or click on [CANCEL] to abort the 
process.

Launching an Attachment:
Launching an attachment file means trying to run the file or trying to run the program the file was created 
with.    For instance, if you receive a Lotus spreadsheet as an attachment, the launch button would cause 
Lotus 123 to be started and the attachment file would be loaded into it.    If the attachment is an 
executable file, the Launch button would try to run the application.    To launch an attachment, simply 
select the desired attachment name, then click on the [LAUNCH] button.

 
View an Attachment:
--    Select the attachment to view from the list of attachments.
--    If the attachment is a WordPerfect or Word file, select the [USE TEXT FILTERS] check box.
--    Click on the [VIEW] button to load the attachment into the viewing window.
--    Use the scroll bar to view the entire contents of the file.
--    When finished viewing, click on the [EXIT] button.

Print an Attachment:
--    Follow the directions above to view an attachment.



--    From within the View Window, select the  button.



Manage Folders

'Manage Folders' allows you to create, rename, delete, or open a Folder Window.    A Folder Window is 
used to display a list of all messages in a Banyan mail folder.

The Manage Folder Box contains a list of all available folders (with the current number of messages) and 
five buttons: [CREATE], [RENAME], [DELETE], [CANCEL], and [OPEN FOLDER].

To exit the Manage Folder Box click on the [CANCEL] button.

To Create a Folder:
--    Select 'Manage Folders' from the Utility Menu, or click on the [FOLDER] button.
--    Click on the [CREATE] button and you will be prompted for a new folder name.
--    Type in a name of 13 characters or less. (Spaces are permitted)
--    Click on the [OK] button to create the new folder, or click on [CANCEL] to abort the operation.

To Rename a Folder:
--    Select 'Manage Folders' from the Utility Menu, or click on the [FOLDER] button.
--  Select the folder to rename from the folder list.
--    Click on the [RENAME] button and you will be prompted for a new folder name.
--    Type in a new name of 13 characters or less. (Spaces are permitted)
--    Click on the [OK] button to rename the folder, or click on [CANCEL] to abort the operation.

To Delete a Folder:
--    Select 'Manage Folders' from the Utility Menu, or click on the [FOLDER] button.
--  Select the folder to delete from the folder list.
--    Click on the [DELETE] button and you will be asked to verify the delete operation.
--    Click on the [OK] button to delete the folder, or click on [CANCEL] to abort the operation.

To Open a Folder:
--    Select 'Manage Folders' from the Utility Menu, or click on the [FOLDER] button.
--  Select the folder to open from the folder list.
--    Click on the [OPEN FOLDER] button and the folder will automatically be opened.    Or,...
--    Double-click on the folder name to automatically open the folder.

Note: The General and WasteBasket folders cannot be renamed or deleted,
and duplicate folder names or not allowed.



Attach Files

'Attach Files' allows you to select file names for attaching to the current mail message.

The Attach Files Box allows the user to select one or more file names from a list of all files available to the
user.

To Select File(s) for Attaching:
--  Select a file name from the list of files in the current directory.
--    Click on the [ADD FILE] button to add the file name to the Selected File Names Box.
Or,...
--    Double-click on the file name in the list of files and the file name will automatically be added to the 
Selected File Names Box.
--    After selecting up to ten file names, click on the [OK] button to transfer the file names to the 
Attachment field of the Compose Window.    Click on the [CANCEL] button to abort the operation.

To Change Drives:
--    Click on the down arrow of the drop-down list of drives.
--    Select a new drive letter from the drop-down list by clicking once on the desired drive letter.
--    The directory list and file list will automatically update to show the new drive and directory.

To Change Directories:
--    Select a new directory from the list of directories by double-clicking on the desired directory name.
--    The directory list and file list will automatically update to show the new directory and its contents.

Note:    The current directory is displayed with a shaded open folder icon.    Its parent directories are 
displayed with a non-shaded open folder icon.    All other directories are displayed with a closed folder 
icon



Import Files

'Import Files' allows you to add a text file to the body of the current mail message.

To Import a File:
--  Select a file name from the list of files in the current directory.
--    Click on the [OK] button to add the file contents to the message body.
Or,...
--    Double-click on the file name in the list of files and the file contents will automatically be added to the 
message body.
--    Click on the [CANCEL] button to abort the operation.

To Change Drives:
--    Click on the down arrow of the drop-down list of drives.
--    Select a new drive letter from the drop-down list by clicking once on the desired drive letter.
--    The directory list and file list will automatically update to show the new drive and directory.

To Change Directories:
--    Select a new directory from the list of directories by double-clicking on the desired directory name.
--    The directory list and file list will automatically update to show the new directory and its contents.

Note:    The current directory is displayed with a shaded open folder icon.    Its parent directories are 
displayed with an unshaded open folder icon.    All other directories are displayed with a closed folder icon



Address Book

'Address Book' allows you to create, edit, delete, and select entries from your personal Banyan address 
book or your personal HappyMail address book.    Selected entries can be copied to any of the various 
recipient fields (e.g. TO: and CC:).

The Address Book Window contains a list of all available address book entries, a list of selected entries, 
and seven buttons: [SELECT], [REMOVE], [ADD], [EDIT], [DELETE], [OK], and [CANCEL].

Address Book Differences:
The Banyan address book is limited to 1024 characters, whereas, the HappyMail address book can 
contain roughly 32,000 characters.    However, the HappyMail address book is only available when using 
the HappyMail system.    The Banyan address book is available both in HappyMail and in Banyan's DOS 
mail client.    Both books are limited to 500 characters per entry.

To Swap Address Books:
--  Select the desired address book from the two choices at the top of the Address Book window.
--    The selected book's contents will be automatically imported into the Address Labels list box.

To Select Address Book Entries:
--  Select an address label from the list of addresses, and click on the [SELECT] button.    Or,...
--    Double-click on the desired address label.
--    The label will be added to the Selected Entries list.
--    After selecting all desired address labels, click on the [OK] button. 
--    To exit without selecting any entries, click on the [CANCEL] button.

To Remove Address Book Entries:
--  Select an address label from the Selected Entries list box of addresses, and click on the [REMOVE] 
button.    Or,...
--    Using the mouse, double-click on the desired address label.
--    The label will be removed from the Selected Entries list.

To Add a new Address:
--    Click on the [ADD] button and you will be prompted for a new address label and address(es).
--    Type in a label of 15 characters or less. (No spaces are permitted)
--    Type in one or more StreetTalk addresses in the Addresses Window. Or,...
--    Click on the [NAMES] button to select from a list of all StreetTalk names.
--    Click on the [OK] button to add the new address, or click the [CANCEL] button to abort the operation.

To Edit an Address:
--  Select an address label from the list of addresses, and click on the [EDIT] button.
--    The label and addresses will appear in and Edit Address Book Window.
--    Modify label or addresses as necessary.
--    Click on the [OK] button to save the changes, or click on [CANCEL] to abort the operation.

To Delete an Address:
--  Select an address label from the list of addresses, and click on the [DELETE] button.

Note:    If the address book is modified and you click the [CANCEL] button in the Address Book Window,    
you will be asked whether or not to save the changes.    Clicking the [OK] button at this time,    will save all 
changes.





StreetTalk Names

'StreetTalk Names' allows you to select Banyan user names (i.e. StreetTalk names) from an alphabetized 
list of all Banyan users.    

The StreetTalk Names Window contains a list of all available StreetTalk names, a list of selected 
recipients, a drop-down list of categories, and four buttons: [SUBSET], [HELP], [OK], and [CANCEL].

To Select a StreetTalk Name:
--    Use the arrow keys or arrow buttons to move through the list of names. Or,...
--    Use the search feature by typing in the first few characters of the last name.
Note: Before using the search feature,    click once on a name in the list of names.    This will insure that 
the keystrokes are not mis-directed.
--    Once the desired user name is visible in the names list, double-click on the name.
--    The name will be added to the list of selected recipients.

To Remove a Recipient Name:
--    Double-click on the recipient name you wish to remove from the Selected Recipients list.
--    The name will be automatically removed from the list of selected recipients.

To Select a StreetTalk Nickname or List:
--    Click on the down arrow of the drop-down list marked StreetTalk:.
--    Select either Nicknames or List.
--    The list of StreetTalk Names will be updated to show all lists or all nicknames.
--    Select an item from the new list as if it were a StreetTalk Name.

Note:  If the search feature is to be used more than once, you must first clear the old search string.    To 
clear the string type an <UP ARROW> or <DOWN ARROW> key, or use the <BACKSPACE> key.



Spell Check

'Spell Check' allows you to check the spelling in the body of your message.    The automated spell 
checker will lookup each word in its 100,000 word dictionary.    Alternate spellings will be offered for words
not found in the dictionary.    Additionally, each user may add new words to their own dictionary.

The Spell Checker Window contains the misspelled word (in the Title Bar), the suggested correct word, a 
list of alternative words, and four buttons: [REPLACE], [SKIP], [ADD TO DICTIONARY], and [EXIT].

To Replace a Misspelled Word:
--    If the suggested word is incorrect, select the correct word from the alternatives list using the arrow 
keys or the mouse.
--    If the correct word is not contained in the alternatives list, move the cursor to the Replacement Word 
box by pressing the [TAB] key or using the mouse.    Type in the correct spelling.
--    Replace the word by selecting the [REPLACE] button using the mouse or by pressing [ALT-R].

To Add a Word to the Dictionary:
--    Add the word to the dictionary by selecting the [ADD TO DICTIONARY] button using the mouse or by 
pressing [ALT-A].

To Accept the Current Spelling:
--    Accept the current spelling by selecting the [SKIP] button using the mouse or by pressing [ALT-S].

To Stop the Spell Checker:
--    Stop the spell checker by selecting the [EXIT] button using the mouse or by pressing [ALT-X].



Closing Signature

'Closing Signature' is a standard footer that can be added to your outgoing mail messages.    The default 
signature is your full name and the words "via HappyMail!".    However, the signature may be modified and
can be expanded up to 500 characters.    To add the signature to your message, simply click on the 
[SIGN] button from the Compose Window.

The 'Closing Signature' itself is modified from the Compose Options window, which is accessed by 
selecting Composing from the Option Menu.    To save the new signature,    click on the [OK] button.    To 
cancel any changes click on the [CANCEL] button.



Exit
Selecting 'Exit' from the Mail Menu will cause Happy Mail to save all its optional settings and close down.



Compose Options
Options associated with composing mail messages are managed from the Compose Options dialog box, 
which is accessed by selecting 'Composing...' from the Options Menu.    The box contains controls for 
modifying the following options:

Automatic Certify:

Default Destination:

Line Length:

Font:

Signature:

To save any changes,    select the  button.    To lose the changes, select the 

 button.



Folder Options
Options associated with Folder Window are managed from the Folder Options dialog box, which is 
accessed by selecting 'Folder...' from the Options Menu.    The box contains controls for modifying the 
following options:

Sort Order:

Font:

To save any changes,    select the  button.    To lose the changes, select the 

 button.



General Options
General options which are not associated with a specific window are managed from the General Options 
dialog box, which is accessed by selecting 'General...' from the Options Menu.    The box contains controls
for modifying the following options:

Disable Warning Messages:

Check for STDA:

Save & Restore Icon Position:

Default Save Directory:

Answer Button Action:

Original Copy Options:

To save any changes,    select the  button.    To lose the changes, select the 

 button.



Printer Options
All options associated with printing are managed from the Printer Options dialog box, which is accessed 
by selecting 'Printing...' from the Options Menu.    The box contains controls for modifying the following 
options:

Footer Options:

Font:

To save any changes,    select the  button.    To lose the changes, select the 

 button.



Read Options
Options associated with Read Window are managed from the Read Options dialog box, which is 
accessed by selecting 'Reading...' from the Options Menu.    The box contains controls for modifying the 
following options:

Delete Button Action:

Font:

To save any changes,    select the  button.    To lose the changes, select the 

 button.



Text Search
The Text Search feature enables you to perform a case-insensitive search through your mail box to find 
all messages which contain a specified string of text. In addition, you can set several parameters to limit 
your search, thereby increasing its speed.    To invoke the text search feature, select 'Text Search' from 
the Utility Menu.

Parameters:
There are three parameters to define and limit the search: the search string, the folder name(s), and the 
search area.

The search string can be one or more words or a portion of a word.    The '&' function is also supported.    
It is important to not use quotes or spaces if    they do not occur in the text you are searching for.

You may select any combination of folder names to search.    Only the folders which are highlighted in the 
list of folder names will be searched.    The default is to search the General folder only.

You may also limit the search by specifying one of two search areas: the 'Envelope', or the 'Message 
Body'.      In this case the word 'Envelope' refers to the text string which appears in the Folder Window.    If 
you are confident the text you are searching for appears in the folder window when viewing the list of 
messages, then you should only search the envelopes.    Otherwise, you should choose to search the 
entire 'Message Body'.

Searching:

To begin the text search simply press the  button.    As the text search progresses, any matches 
will be displayed in the Matches list box.    If you wish to halt the search at any time, simply select the 

 button.    Once the search has completed, any of the matching messages may be viewed by 
highlighting the message and selecting the 

 button.    As an added convenience, the text search box may remain on the screen while you read
your messages. 



Selecting Items from a List Box

To select a single item: 
Mouse:
--    Using the left mouse button, click the scroll arrows until the item you want to select appears in the list 
box.
--    Place the mouse pointer over the item to select and click the left mouse button. 

Keyboard:
--    Use the arrow keys to scroll to the item you want to select.
--    Continue scrolling unitl the highlight bar is over the item you wish to select.    

To select multiple sequential items: 
Mouse:
--    Click the first item you want to select and drag the cursor to the last item you want to select. (To drag 
the cursor,    keep the mouse button pressed and move the mouse down.)    Or, ....
--    Click the first item you want to select. Press and hold the <SHIFT> key, and click on the last item you 
wish to select.    Both items, and all items in between, are selected.
--    To cancel the selection click on any item in the list.

Keyboard:
--    Use the arrow keys to scroll to the first item you want to select.
--    Press and hold the <SHIFT> key.
--    Continue to press either the <UP ARROW> or <DOWN ARROW> key until all the items you want to 
select are highlighted.
--    To cancel the selection, release the <SHIFT> key and press either the <UP ARROW> or <DOWN 
ARROW> key.

To select multiple nonsequential items: 
Mouse:
--    Press and hold the <CTRL> key, and click on each item you wish to select.    
--    To cancel a selection,    press and hold the <CTRL> key, and click on the item again.

Keyboard:
--    There is no keyboard equivalent for this procedure.



Attach

The Attach: field is used for attaching files to your mail messages.    The names of up to ten files may be 
placed in this field.    Each file name should be separated by a comma.

You may use the [ATTACH FILES] button to add file names, or alternatively, you can type the names of 
the files you want to attach in the Attach field.    If the file you are attaching is not in the current directory, 
be sure to specify the COMPLETE pathname, including the drive and directory.

The file names are validated only after the [OK] button has been clicked. If an invalid file name is found at 
that time, a warning message is displayed and the invalid filename is highlighted.

Note: when forwarding a message, this field appears grayed out, and you are unable to modify it.    This is
because the attachments of the original message are forwarded.

See Also: Attach Files , Managing Attachments



Bcc
The Bcc: field should contain the names or addresses of the recipients of "blind carbon copies" of your 
mail message.    The names of people who receive blind copies of the message do not appear in the 
primary recipient's message.

You can address messages to users and lists of users by specifying their StreetTalk names in the Bcc: 
field.    Names should be separated with a comma.

For example:

Bill,Bob@Sales@Datatron,Mary

If you need help finding names, you can access the Banyan catalog of StreetTalk names by clicking on 
the [NAMES] button.    The Select Names Window appears.    You can search for users, lists, or 
nicknames, and you can select names for automatic insertion into the Bcc field.

You can also click on the [ADDRESS BK] button to display your on-line address book.    You can select 
entries from your address book for automatic insertion into the Bcc field.

When you are finished composing the message, Happy Mail checks to make sure that all names in the 
address fields are valid.    If all addresses are valid, you can send the message.    If Happy Mail does not 
recognize a recipient address, Happy Mail notifies you with a message, and highlights the unverifiable 
address allowing you to correct or delete it.



Body
The Body: field should contain the body of your message.    It can hold up to 60000 characters, including 
spaces, tabs, and blank lines.    You can import text from a DOS file with the [IMPORT FILES] button.    
The combination of your text and the DOS file must be within the 60000-character limit.

KEYBOARD SHORTCUTS:

TO MOVE CURSOR TO                USE  
Beginning of line Home
End of line End
Beginning of message Ctrl-Home
End of message Ctrl-End
[OK] Button Ctrl-Tab
Beginning of next word Ctrl-Right Arrow
Beginning of previous word Ctrl-Left Arrow

TO DELETE                                     USE  
To end of line Ctrl-End

TO SELECT TEXT                          USE  
Next word Shift-Ctrl-Right Arrow
Previous Word Shift-Ctrl-Left Arrow
To End of Line Shift-Ctrl-End
To Beginning of Line Shift-Ctrl-Home

MOUSE SHORTCUTS:

TO MOVE CURSOR                       USE  
Anywhere in window Move mouse cursor to proper insertion point and click once.

TO SELECT TEXT                          USE  
A word Move mouse cursor to word and double-click.
A line Move mouse cursor to beginning of line. Click and hold mouse 

button. Drag mouse cursor down one line.

When you have finished entering text, click on the [OK] button.    To completely erase a message while 
composing, press <ESC> or click on the [CANCEL] button.



Cc

The Cc: field of a message should contain the names of the recipients of "carbon copies" of your mail 
message.    Since this is an electronic message,    there is no difference in the "quality" between a regular 
message and a "carbon copy".    This field provides a convenient spot to put the names of    people who 
are not the primary recipients but who might like to receive a copy of it anyway.

You can address messages to users and lists of users by specifying their StreetTalk names in the Cc: 
field.    Names should be separated with a comma.

For example:

Bill,Bob@Sales@Datatron,Mary

If you need help finding names, you can access the Banyan catalog of StreetTalk names by clicking on 
the [NAMES] button.    The Select Names Window appears.    You can search for users, lists, or 
nicknames, and you can select names for automatic insertion into the Cc: field.

You can also click on the [ADDRESS BK] button to display your on-line address book.    You can select 
entries from your address book for automatic insertion into the Cc: field.

When you are finished composing the message, Happy Mail checks to make sure that all names in the 
address fields are valid.    If all addresses are valid, you can send the message.    If Happy Mail does not 
recognize a recipient address, Happy Mail notifies you with a message, and highlights the unverifiable 
address allowing you to correct or delete it.



Certify

The Certify: field of a message is used to request the mail system to tell you when this message is read 
by each recipient.

If you have an important message that you would like to have "certified", place a check mark in the Certify
Box (by clicking on the field with the mouse). You will receive a confirmation mail message for each 
recipient when that recipient reads, files, or prints the message for the first time.

See Also: Automatic Certify



Defer
The Defer: date and time fields are used to postpone delivery of a mail message to the specified time.    
Leaving these fields blank will cause the message to be sent as soon as possible.



Expire
The Expire: date and time are used to set an expiration date for the message.    If a message expires 
before it is delivered to a recipient's mailbox, it will be returned to the sender as undeliverable.    It will not 
be deleted from a users mail box once it has been received.    Leaving these fields blank, will cause the 
mail system to use the default expire time, which ranges from 1 day to 1 week depending on the message
priority.



Priority

The Priority: fields are used by the mail service to determine how much time to spend processing a 
message.    In general, a high priority message will be sent faster than a low priority message.    If a 
priority setting appears grayed-out and is unselectable, it is because your network administrator has not 
authorized you to use that setting.



Subject

The "Subject" field can consist of up to 63 characters describing the content or purpose of your message. 
Be sure to make the first 24 characters of the subject meaningful, because Happy Mail displays only the 
first 24 characters of the subject in the Folder Windows.

Note: when forwarding a message, this field appears grayed out, and you are unable to modify it.    This is
because the subject line of the original message is used when forwarding.



To

The To: field should contain the names or addresses of the primary recipients of your mail message.

You can address messages to users and lists of users by specifying their StreetTalk names in the To: 
field.    Names should be separated with a comma.

For example:

Bill,Bob@Sales@Datatron,Mary

If you need help finding names, you can access the Banyan catalog of StreetTalk names by clicking on 
the [NAMES] button.    The Select Names Window appears.    You can search for users, lists, or 
nicknames, and you can select names for automatic insertion into the To: field.

You can also click on the [ADDRESS BK] button to display your on-line address book.    You can select 
entries from your address book for automatic insertion into the To: field.

When you are finished composing the message, Happy Mail checks to make sure that all names in the 
address fields are valid.    If all addresses are valid, you can send the message.    If Happy Mail does not 
recognize a recipient address, Happy Mail notifies you with a message, and highlights the unverifiable 
address allowing you to correct or delete it.



Label

The Label: field is used to give a label to an address book entry.    Use a concise name so it will be easy 
to remember.    You can use a maximum of 15 alphanumeric characters for a label.



Address

The Address: field is used to specify the names associated with an address book label.    The names can 
include StreetTalk users, nicknames, and lists, and addresses of users on gateways and VINES servers 
with restricted or temporary connections to your own.

In the Addresses field, enter one or more names of the users and lists you want the label to represent.    
Separate each name with a comma or a carriage return.

If you need help finding names, click on the [NAMES] button to access the Happy Mail catalog of 
StreetTalk names. When the Select Names Window appears, you can search for names and select them 
for automatic insertion into this field.

When you finish entering names, click on [OK] to save new address book entry.

To cancel the changes to the address book at any time,    press <ESC> or click on [CANCEL].    



Folder Name

The Folder Name: field is used to specify a new name for a mail folder.    You may use a maximum of 13 
alphanumeric characters for folder names (spaces are allowed).    Happy Mail does not allow duplicate 
folder names.



Automatic Certify
When the 'Automatic Certify' option is enabled, all outgoing mail will have the certify box automatically 
checked.    The certify box can still be changed manually, if necessary.

This field is modified from the Compose Options window, which is accessed by selecting Composing from
the Options Menu.



Default Destination
The 'Default Destination' option allows you to specify which destination will be highlighted by default when
you select the [OK] button from a Compose Window.    By default, the 'Send & Delete' option is 
highlighted.    

This field is modified from the Compose Options window, which is accessed by selecting Composing from
the Options Menu.



Line Length

The Line Length: field allows you to specify the number of characters per line in mail messages you 
create.    The default line length is 78 characters which is equivalent to the line length used by Banyan's 
mail system.    In general, this option only affects the way your message appears in other mail packages 
(e.g. Banyan's DOS mail).

WARNING: This option should not be changed unless you are noticing formatting problems with 
messages you are sending.    Increasing or decreasing this value by too much can cause your outgoing 
mail messages to be incorrectly formatted.

This field is modified from the Compose Options window, which is accessed by selecting Composing from
the Options Menu.



Compose Font
The 'Compose Font' option is used to specify the font for displaying text in the Compose Window.    The 
font is modified from the 'Select Font' dialog box which is accessed by selecting the  button.      From
the 'Select Font' window you may choose a font type, size and style. 
 

The 'Compose Font' field is modified from the Compose Options window, which is accessed by selecting 
Composing from the Options Menu.



Closing Signature

The Closing Signature: field is used to specify a standard footer for your mail messages (a maximum of 
500 characters).

The default signature is:
Your Name
via HappyMail!

To add the closing signature to your mail message click on the [SIGN] button from the Compose Window.

This field is modified from the Compose Options window, which is accessed by selecting Composing from
the Options Menu.



Sort Order
'Sort Order' allows you to change the order in which messages are displayed in the Folder Windows.    
You may select from four different orderings: by date, by name, by subject or by status.    If a new ordering
is selected, all folders will immediately be resorted.    The new ordering will only be in affect for your 
current HappyMail session.    If you exit HappyMail, the ordering is reset to the default -- by Date.

This option is modified from the Folder Options window, which is accessed by selecting Folder from the 
Options Menu.



Folder Font
The 'Folder Font' option is used to specify the font for displaying text in the Folder Window.    The font is 
modified from the 'Select Font' dialog box which is accessed by selecting the  button.      From the 
'Select Font' window you may choose a font type, size and style. 

The 'Folder Font' field is modified from the Folder Options window, which is accessed by selecting Folder 
from the Options Menu.



Disable Warning Messages
The 'Disable Warning Messages' option allows you to disable some of the more obvious warning 
messages.        For example,    when more than one message is selected and you attempt to print, file, or 
move the messages, you will be asked to confirm the operation.    This confirmation message is 
eliminated if you have enabled the are using the Disable Warning Messages option    

Note:    This option should not be enabled by novice users.

This option is modified from the General Options dialog box, which is accessed by selecting 'General' 
from the Option Menu.    



Check for STDA
The 'Check for STDA' option allows you to disable all use of STDA within HappyMail.    This feature is 
designed for networks which do not use the STDA service or for those who are having temporary 
problems with STDA.      This option is enabled by default, and should not be disabled unless you are 
receiving error messages regarding STDA.    

WARNING: When this option is disabled you will not be able to access the StreetTalk Names window 
while composing a message.

This option is modified from the General Options dialog box, which is accessed by selecting 'General' 
from the Option Menu.    



Save and Restore Icon Position
The Save and Restore Icon Position option allows you to cause HappyMail to always appear in the same 
place when minimized.    The default is not to save and restore the icon position.    

WARNING:    If this option is enabled, it is possible for other icons to be automatically placed on top of the 
HappyMail icon, thus hiding it from view.      For best results when this option is enabled, the icon should 
be moved off of the bottom row where icons are normally placed.    

This option is modified from the General Options dialog box, which is accessed by selecting 'General' 
from the Option Menu.    



Default Save Directory
'Default Save Directory' is the default drive and directory for storing attachments and mail messages 
when they are saved to DOS files.    The default, which is initially set by your system administrator, may 
be changed to any drive and directory to which you have access.

The 'Default Save Directory' option is modified from the General Options dialog box, which is accessed by
selecting 'General' from the Option Menu.    The default path will be displayed in an edit window where 
you may modify it as necessary.    The path for the default directory may be modified directly or for 
convenience the path may be selected from a list box of drives and directories by selecting the  
button.    To save the modified path,    click on the [OK] button.    To cancel any changes click on the 
[CANCEL] button.



Answer Button Action
The 'Answer Button Action' option allows you to modify the default action of the Answer button.    The

 button which appears in the Folder and Read window allows you to reply to any received 
message.    By using this option to change the default action, you can force the reply to go to all the 
original recipients and/or you may include a copy of the original mail message in the body of your reply.    

This option is modified from the General Options dialog box, which is accessed by selecting 'General' 
from the Option Menu.    



Original Copy Options
The 'Original Copy Options' allow you to modify how the original mail message appears when you use the
Original Copy feature to include the original mail message in your reply.    If the 'Use a Header & Footer' 
option is selected, the original message will have a header stating "- - - Original Message - - -" and a 
footer stating "- - - End of Original Message - - -".      If the 'Use a Prefix String' option is enabled, each line
of the original message will be prefixed by a short string of text (e.g., the '>' character).    When using this 
option you may specify your own string to use as a prefix.    The prefix string is limited to 5 characters.

These options are modified from the General Options dialog box, which is accessed by selecting 'General'
from the Option Menu.    



Footer Options
The 'Footer Options' allow you to modify the appearance of the footer on all HappyMail printouts.    By 
selecting these options you may add or delete the HappyMail Logo, the page number, and/or the date 
from all printouts.

These options are modified from the Printer Options dialog box, which is accessed by selecting 'Printing' 
from the Option Menu.    



Printer Font
The 'Printer Font' option is used to specify the font for printing text.    The font is modified from the 'Select 
Font' dialog box which is accessed by selecting the  button.      From the 'Select Font' window you 
may choose a font type, size and style. 

The 'Printer Font' field is modified from the Printer Options window, which is accessed by selecting 
'Printing' from the Options Menu.



Delete Mode
'Delete Mode' determines the action of the Read Window when a mail message is deleted.    Three 
options are available:
1. Delete the current mail message and close the Read Window (return to the Folder Window).
2. Delete the current mail message and proceed to read the Next message,
3. Delete the current mail message and proceed to read the Previous message.

The 'Delete Mode' option is modified from the Read Options dialog box, which is accessed by selecting 
'Reading' from the Option Menu.    Three radio buttons will be displayed showing the three possible 
actions: [DELETE AND CLOSE],    [DELETE AND NEXT], and [DELETE AND PREVIOUS].    Click on the 
desired action,    then click on the [OK] button to save the change.    To cancel any changes click on the 
[CANCEL] button.



Read Font
The 'Read Font' option is used to specify the font for displaying text in the Read Window.    The font is 
modified from the 'Select Font' dialog box which is accessed by selecting the  button.      From the 
'Select Font' window you may choose a font type, size and style. 

The 'Read Font' field is modified from the ReadOptions window, which is accessed by selecting 'Reading' 
from the Options Menu.




